Excel Basics
You will need Microsoft Word, Excel and an active web connection to use the Introductory Economics Labs materials. The Excel workbooks are saved as .xls files so they are fully compatible with 97-2003 versions of Excel. If you are using Excel 2007 or greater, you should save the files as .xlsm to preserve the embedded macros. Mac users will need a version of Excel that runs Visual Basic or Windows emulation.  

Most of the screenshots in these labs are based on Excel 2007. Excel 2010 will look very similar, but older versions may look different. You should be able, however, to figure out what to do in any version.

This document explains how to 1) open a macro-enabled workbook and 2) create a chart.
Properly Configuring Excel
To make sure that Excel is able to access and run Visual Basic macros, security must be properly set.  If buttons, scroll bars, and other objects do not work, it is likely that macros have not been enabled.
The interface for configuring Excel depends on the version being used, but all are basically the same: set up Excel so that macro-enabled workbooks trigger a prompt enabling confirmation that the file is to be opened. This macro setting is accessed through the Options dialog box, which is different on different versions of Excel. 
In Excel 2010, from the File menu, select Options. Excel 2007 users should click the Office button, then Excel Options (at the bottom). With the Excel Options dialog box open, Excel 2010 and 2007 users should select the Trust Center and click on the Trust Center Settings button.  In the Trust Center, select the Macro Settings heading, choose the “Disable all macros with notification” option (this is often the default).
For Excel 2003 and earlier, from the Tools menu, select Macros and then Security. Choose Medium in the Security Level tab (which is often the default).
Opening a workbook

When opening a workbook with macros, Excel 2007 and greater will alert you to their presence with a security warning under the ribbon, as shown in Figure 1.
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 Figure 1: Opening a workbook with macros in Excel 2007 or greater.
Click the Options button, then click “Enable this content” to allow the buttons and other controls in the workbook to function properly. Excel 2010 users are often prompted to make this file trusted so that macros will be enabled automatically the next time the file is opened.
Do not enable macro functionality unless you are completely confident that the workbook is safe.

You may also receive the warning displayed in Figure 2 when opening a workbook with macros.
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Figure 2: Macros Warning.

In Excel 2007 and greater, save a file as .xlam (macro-enhanced workbooks) to preserve the macros in the workbook. Files are originally .xls to allow users with older versions of Excel access to the files.
Creating a Chart in Microsoft Excel

In Excel, charts (also known as graphs, plots, and diagrams) are created by selecting data, then clicking on a chart type button (or using the Chart Wizard button in older versions of Excel).
This document will show you how to make a simple chart using the Scatter (or XYScatter in older versions of Excel) chart type.  Excel has many other chart types, but the Scatter is by far the most often used chart in economics. Along the way, we offer a few style tips.  Creating a chart is a mix of art and science. Some things are just plain wrong, while others are simply ugly.

The document concludes with two common charting mistakes to avoid:

· The dreaded “Series 1” legend text—never leave a chart with a “Series” legend text.
· The poorly chosen axis range—make the chart visibly appealing and informative.
How To Make a Chart in Excel
To make a chart, numbers are needed. The example below is based on a recent working paper that explores how much time students spend studying, with the twist that the authors cleverly string together a series of surveys from 1961 to 2003. Here’s the source and abstract:
The Falling Time Cost of College: Evidence from Half a Century of Time Use Data

Philip S. Babcock, Mindy Marks

NBER Working Paper No. 15954

Issued in April 2010

Using multiple datasets from different time periods, we document declines in academic time investment by full-time college students in the United States between 1961 and 2003. Full-time students allocated 40 hours per week toward class and studying in 1961, whereas by 2003 they were investing about 27 hours per week. Declines were extremely broad-based, and are not easily accounted for by framing effects, work or major choices, or compositional changes in students or schools. We conclude that there have been substantial changes over time in the quantity or manner of human capital production on college campuses.

The primary results are captured in this table:
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We will focus on liberal arts colleges. On a blank Excel worksheet, enter the following text in the first row and numbers:
[image: image4.wmf]Year

Avg Study Time

1961

28.96

1981

24.62

1988

17.49

2003

16.34


Read the instructions below carefully and do each step in order. There are three basic steps: 
1. Select the data

2. Click a chart type button (usually Scatter)

3. Clean up and improve the chart.
Step 1. Select the cells you want to graph including the text that describes the data. To plot the average study time, select the data that you just typed in. Always select from the top left to the bottom right. Selecting right to left or down to up seems to sometimes confuse Excel. 

You can select non-contiguous (or non-adjacent) cells by holding down the CRTL key (or COMMAND key on a Mac) after you select the first cell or group of cells. Keep holding down the CTRL key as you add more non-contiguous data to already selected data. 

TIP: Holding down the CTRL key before you start selecting the data you want to graph is a common error and will seriously confuse Excel. Remember, select the first range of cells, THEN hold down the CTRL key and select the next range. 

With the cells selected (highlighted on your screen), you are ready for the next step.

Step 2. From the Insert tab found on the upper-left hand part of the Ribbon, click on the Scatter button that is located in the Charts group of the Insert tab.
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After you have clicked on the Scatter button, you will be presented with the five options shown above. Clicking one of these buttons, preferably NOT the smoothed line options, will create the scatter plot of the selected data IN THE SAME SHEET as the data.

NOTE: Scatter is the most common type of chart used in Economics because we are often interested in showing how one variable depends on another. 

TIP: Avoid the smoothed sub types!  You may think it looks prettier, but there is no reason to use this option on plotted data.  If you are fitting a line or curve, there are better ways than creating a smoothed chart.

In older versions of Excel, after selecting the data, you click the Chart Wizard button and you are presented with a several chart types to choose from. Select XYScatter and walk through the Chart Wizard to create the chart.

Applying the two steps above to the study time data produces this chart:
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Step 3. After you have created a chart, there might be some cleaning up that needs to be done. Click the chart itself to bring up the Chart Tools group in the ribbon in Excel 2007 or greater. The chart above does not require a legend because there is only one series being plotted. Select the legend and press the delete (not backspace) key to remove it. The x axis is fine because the year is obviously being displayed, but the y axis needs a label. In Excel 2007 and greater, click the y axis and use the Layout group in the Chart Tools to add a label. The finished product looks like this:
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The cleaned up chart is better than Excel’s original chart (at the top of this page). It is more informative and does not have the distracting legend text. Remember, use legends only when plotting more than one relationship
Sizing 

If you want to change the size of the chart, you can click on one of the ‘handles’ located on the corners and sides of the box and drag it until you have obtained the desired dimensions. These handles show up only when the ‘object’ (in this case, the chart) has been selected. 

You can also move the whole picture by clicking and dragging it if the cursor is in the shape of a four-sided arrow. 

Editing 

Making changes to an already created chart in Excel is pretty easy. The general rule is to right-click on whatever you want to change. After right-clicking on an item you wish to change, look for the “Format…,” which will be located at the very bottom of the drop-down menu. After clicking on this button, you will be able to detail the selected item.

If you let the cursor rest for a moment, Excel tells you what object you have under the cursor. This helps if you are having trouble getting the options for a particular part of the chart. 

Switching the X and Y variables

Excel automatically assumes that the data in the first (furthest left) column is the X, or independent, variable. If your X variable is not located in the first column, you need to do some editing to change the variables in the chart.

A powerful way to make changes is by directly editing the series. Click once on the plotted data on the chart and note that the source data appears as a formula in the formula bar. The first part is the legend text, then comes the x axis, then the y axis, and finally the series number (each separated by a comma). 

TIP: Excel plots data as a SERIES formula with a structure like this:
=SERIES(legend text, x axis data, y axis data, series number)

The two charts below show how the series formula determines the chart being depicted. Note how the axes are switched by changing the order in which the data ranges $A$2:$A$5 and $B$2:$B$5 appear in the series formula.
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TIP: Once you have a chart nicely formatted and set up as you like it, you can copy and paste that chart, then change the series by simply editing the series in the formula bar. 

We think the secret to good charting practice in Excel (and any other software) is to always remember step 3: Clean up and improve the chart. Excel will usually make a decent chart, but you should always examine the chart with a critical eye. It is not necessary to add colors and other fancy aspects (and smoothing data is almost never a good idea), but always check to make sure you have a descriptive title, well-labeled axes, and that the legend text is correct and needed. We conclude the charting primer with two common mistakes.

Two Common Graphing Mistakes to Avoid Like the Plague
Mistake 1) The “Series 1” legend text
If the group of cells that you select to create the chart does NOT contain cells with text in the first row and you ask for a legend, Excel complies by creating a legend box with the “Series #” as the legend: 
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This is NOT good graphing. “Series 1” means nothing. 

There are two solutions:
A) If you want a legend, make sure that the first row (if your data are organized in rows) of your selected data range has text for the legend. 

B) Inspect your chart after initially creating it and delete the dreaded “Series 1” legend text. 

TIP: If you are graphing only one variable against another, a legend is unnecessary. Legends should be used only when graphing more than two variables. 

Mistake 2) The Poorly Chosen Axis Range 
While Excel can usually be counted on to make good choices concerning the x and y axes range, it is up to you to make sure that the range on each axis is appropriate. 
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In the graph above, the y axis ranges from 0 to $4,000, but the data points go from only 0 to $400. The y axis range is chosen poorly here because there is too much wasted space and the display is misleading. 

You can improve this chart by fixing the y axis. In Excel 2007 or greater, right-click on the y-axis and select “Format Axis.” (double click the y axis in earlier versions of Excel). This will pop up the Format Axis dialog box in which you can change the values included in the y-axis. The best option would be to select “Fixed” in the Maximum option and set it to 500. This will make the graph look much better.
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TIP: When you want to change something in Excel, RIGHT CLICK on it to bring up a context-sensitive dialog box and adjust the settings as needed.
Click the Enable Macros button to have access to the features in the workbook, but do not enable macros if you are unsure of the source.  








Avoid the smoothed sub types of scatter plots!
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